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Manuals:

The SPAW model descriptive manuals are written as three separate documents, each with a different level of user interest or question in mind.  The three manuals by necessity have some overlap and duplicative material since they are describing the same simulation model.  They do, however, address similar descriptions in a progressively detailed manner.

SPAW Operational Manual:  This manual is intended to answer rather immediate and specific user questions while actually operating the model by manipulating the screen functions.  Most emphasis is placed on data and function descriptions to insure correct model application.

SPAW Users Manual:  This manual describes the model functions and typical applications to provide the user with ideas and concepts about these applications.  Descriptive detail is sufficient to assure that the model is being applied to a proper situation and with correct analytical interpretations.

SPAW Reference Manual:  This manual provides details about the model logic, algorithms and their source.  This material will be useful to the user who desires to know the scientific basis embodied in the model and the supportive reference material.  Soil water hydrology, pond hydrology and soil chemistry are sufficiently complex that even this level of manual will not provide the full documentation and the user will need to rely on reference reading to develop the full skill level included in the SPAW knowledge applications.

Predictive programs such as SPAW are continually being modified, supplemented, tested and revised.  Thus, new versions are developed just as new models of manufactured machines are brought to the market.  While SPAW has now been developed to a stage of correctness and utility, users would be advised to check the WEB site (http://www.bsyse.wsu.edu/saxton/spaw) or correspond with the authors or supporting agencies before extended new applications.  This manual applies to the SPAW model version 6.1.

SPAW Hydrology

The SPAW model is a daily hydrologic budget model for agricultural fields. It also includes a second routine for daily water budgets of inundated ponds and wetlands, which utilizes the field hydrology as the watershed.  A hydrologic budget such as being simulated for either an agricultural field or pond requires the definition of a hydrologic system and associated processes.  The field budget utilizes a one-dimensional vertical system beginning above the plant canopy and proceeding downward into the soil profile a sufficient depth to represent the complete root penetration and subsurface hydrologic processes (lateral soil water flow is not included).  The pond hydrologic system is for a water holding depression with external inputs from a watershed and other water sources and outflow by spillways, pumps or seepage.  The following schematics describe the field and pond hydrologic systems and each major hydrologic process impacting water movement across the system boundaries and within the systems.  These are the systems and processes represented mathematically in the field and pond hydrologic simulation model and become the basis for analytical hydrologic budgets.


SPAW-Field

The SPAW model is a daily, field scale vertical water budget, given that the field can be considered, for practical purposes, spatially uniform in soil, crop and climate.  These considerations will limit the definition of a “field” depending on the local conditions and the intended simulation accuracy.   For many typical farm cases, the simulation will likely represent a typical farm field of tens to a few hundred acres growing a single crop with only slight variations of soil water management characteristics.  In other cases, a single farm field may need to be divided into separate simulation regions because of distinct and significant differences of soil or crop characteristics.  These definitions and divisions will depend on the accuracy required.  Making a number of alternative solutions will soon provide the user with enough experience to guide these choices.

The SPAW model has no infiltration time distribution less than daily and no flow routing, thus is generally not applicable for watershed hydrologic analyses.  However, it can be utilized for water budgets of relatively small watersheds composed of multiple farm fields, each simulated separately and the results combined.  With no streamflow routing there are no channel descriptors included.  Daily runoff is estimated by the USDA/SCS curve number method as an equivalent depth over the simulation field.  The field hydrologic budgeting by SPAW has been enhanced by the addition of an irrigation field budget (scheduling), a soil nitrogen budget, and the effects of salinity.  The combined field concept to represent a watershed is used as the input source for the pond simulations.

SPAW-Pond

The SPAW-Pond model simulates the daily water budget of an inundated depression or constructed impoundment.  The water supply to the inundated area is either runoff from one or more previously simulated SPAW-fields or from a described external source such as an off-site pump or facility flush water.  Climatic data are provided from the SPAW-field simulation.  Additional features are included such as outlet pipes, outlet pumps, irrigation demands and water tables such that a wide variety of pond situations can be described.  Examples are within-field wetlands, water supply reservoirs, lagoons and seasonal waterfowl ponds.
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Model Overview

With the program installed and the main screen visible, use the following procedure to begin hydrologic analyses.  Each user must be identified before making a simulation to provide this information on the output.  If you completed the User Information at the start screen, it has been filed and is available; otherwise find it again under "Options" and enter your identification information.

Before beginning a simulation, fully describe the field climate, soil and crops.  Screens under the heading Data provide these inputs.  All data except the climatic data are entered and stored by the input screens and appropriately filed for ready retrieval by the program file finder.  This allows developing “common” climate, soil and crop files for the regional conditions, then selecting them as needed to represent a particular field or pond.

Climatic Data files are obtained from an external source such as the USWB Climatic Data Center or USDA-National Water and Climate Center. <http://www.wcc.nrcs.usda.gov/water/quality/frame/wetdrn/Tools/tools.html>. 

 All climatic files generally include daily precipitation and max/min air temperature, but may also include evaporation, snow depth, etc.  The climate files labeled “xxx.txt” are manually copied into the SPAW directory at “SPAW Hydrology/SPAW/Database/Climates/Data”.  The Data/Climatic Data screen is used to review, check and modify the available climatic data files.  

Evaporation Defaults data are specified because daily evaporation are often either not available or only available for summer seasons, therefore an estimating method is required.  These default data represent a generalized region such as a county, part of a state, etc. and can generally be applied to multiple fields within the that region.  

Location Climate provides data for the specific field being simulated assigned from the climatic and evaporation default data plus other information.

Soil descriptions are entered as a layered profile with flexible layer number and depths such that the entire profile to at least the maximum crop rooting depth is included.  The water holding characteristics of each layer are assigned by designating the approximate soil texture.  Completing the soil description are choices for USDA/SCS runoff curve number definitions, lower layer drainage option, water tables and ground water chemistry.

The Soil Water Characteristics triangle is selected by clicking the box between the thickness and sand columns of the Soil screen and provides an optional aid.  This texture triangle shows the estimated soil water characteristics by various sand–clay (&silt) percentages based on historic data summaries.  In addition to effects of texture, other variable effects are estimated such as that of organic matter, salinity, gravel and compaction.  The settings in the texture triangle are transferred to the soil layer from which the triangle was initiated.  The model uses the same estimating methods as that displayed in the texture triangle.

Crop descriptions are specified as annual crop growth characteristics tabulated for the complete calendar year as break points which describe the crop canopy cover, canopy greenness, rooting depth, and water stress yield susceptibility (optional).  Additional crop definitions include water interception, wilting susceptibility, and variables related to the USDA/SCS runoff curve number assignment.  General crops definitions for a region are usually described and filed for later selection to a particular field.  

Management of the field includes crop rotations and optional irrigation and nitrogen applications.  Crop rotations are specified as one to several consecutive years of previously defined crops.  The rotation is repeated sequentially through the analyses period.  Designation of irrigation and chemical applications are specified for each rotation year as appropriate.

Projects provides for opening either a Field or Pond simulation project.  The selection menu is composed of location-field or location-pond descriptions and shows those previously named or creates new descriptions.  The designations are user defined.  The location may be a general region, farm or common name for a simulation set, while the field and pond names are specific to the simulation site within that location.  These are files in the computer directory structure under the SPAW model used to store all subsequent input and output files relative to that simulation.

A Field simulation is selected after completing the descriptive climatic, soil and crop information necessary for hydrologic simulation.   The "Field" screen selects the appropriate data sets previously developed, any observed data for comparison or adjusting the simulation, the simulation period, a review or adjustment of the runoff curve numbers and selection of output budgets.  

A Pond simulation is selected similar to a Field, with the exception that at least one Field must have been previously simulated to represent the pond watershed.  More than one Field may be combined to represent more complex watersheds.  The Pond screen provides descriptive input parameters for the pond configuration, watershed field selection, and related hydrologic influences such as pumps, spillways, water table, seepage and fields irrigated with pond water.  If the pond analysis is for hydrologic definition of a wetland, definition parameters for the Wetland Growing Season are entered.  Curve numbers are calculated from the previously entered crop and soil parameters, but can also be entered manually.  Setting the simulation period and output file selection completes the information for a Pond simulation.  Results are found under "View" as for the Field simulation.

The View menu provides either tabular or graphical outputs of the current Project that is open and previously simulated.  The various tables selected in the run screen are available and can be filed and printed.  The Depth Duration and Inundation files are output files of the Pond model.  The Detailed Budget and Input Data File are largely used for program verification.   The Graph view provides and extensive list of variables that can be selected and viewed for the complete simulation period.

The Window option allows maintaining viewable windows of results or screens for multiple runs.  This is particularly useful for easy comparison of sequential inputs or outputs.  

The Help Provides detailed information about each screen and function, plus detailed documentation, images and a tutorial.  The “About” menu provides the SPAW version number and the computer system information at the current time. 
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SPAW Screen Functions

This version of SPAW Hydrology was programmed in Visual Basic utilizing the common format of WINDOWS screens.  Many of the input and output functions will appear and function similarly while others may be somewhat unique.  The following is a summary of those most commonly used.
WINDOWS standards

SPAW screens have been programmed in Visual Basic for WINDOWS to provide easy and guided input data for the SPAW simulations.  The screens use nearly all "typical" WINDOWS functions in terms of opening and closing panels, multiple panels being open, print and save functions, etc.  Questions related to these standard functions can best be solved by reference to the WINDOWS manual or Help Screens.

Box Entries:  Data and other information can be entered in the appropriate "boxes" on the input screens by positioning the active screen pointer into the box and entering from the keyboard.  Copy and paste options are generally not available.  Numbers will be set to the appropriate decimals places.  Many data entries have upper and lower "reasonable" limits programmed to avoid "unreasonable" values for that parameter.  

Date Entries:  Many parameters require a date associated with the value.  Date values may be entered in one of several formats with identical results such as mm-dy-yr, dy-mm-yr, mm/dy/yr, May 10, 2002, etc.  In addition, double clicking a date box will bring forward a calendar screen from which a date can be set which will be entered as the calendar screen is closed.  Some dates require an associated year, either calendar or rotation, while others do not.

Cursor and tab selection:  Positioning the cursor at an entry location and a left mouse click will access all screens functions.  Generally the easiest method is to use a mouse controlled pointer.  However, all functions can also be selected by using the "tab" key to step through the screen in a predefined pattern.  Using shift-tab reverses the tab direction.  Some functions also can be initiated by using "hot keys" indicated on the screen title.  These "hot keys" are used by simultaneously holding down the "Alt" key and the key of the designated letter. Typical with WINDOW programs, several window panels can be open simultaneously within the limits of the computer memory capacity.  This is particularly useful for visually comparing several different simulation results or data options.
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File

Save and Print options are standard WINDOWS functions.  

Previously run simulation screens can be reopened from the list provided by selecting and a mouse click or enter key.
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Edit

"Find" functions are available when an editable screen is open from View.  A particularly useful application is to view the "Detailed Budget" file and search for the word "error".  Any simulation difficulties encountered by the program during simulation such as unusual data or results will generate an "error" statement within this output file on the date of occurrence.
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Options

Units

While the SPAW model was develop and largely operates with English units, conversions to Metric units have been added in most input and output tables.  The user may note some very minor discrepancies in the water budgets as a result of these conversion calculations, but these should not be significant to any hydrologic analyses. Typical value conversions would be:  acre/hectare, inch/millimeter, feet/centimeter, etc. 

User Information

It is important to document the user identification on the results of each hydrologic simulation, thus each user is requested to input this information, which is printed on each simulation output.  Multiple users can be identified on the same SPAW model and selected at the beginning of a simulation session.

Program

Recent program runs can be listed and re-opened under the File menu.  The number of these previous listed is selectable with 2-6 runs most common.

The SPAW model establishes multiple files of data and simulation results related to a single simulation.  The simulation procedure is to first establish the data files in a disk directory, then assemble these files into a field or pond representation at the time of simulation.  This requires that the directory access file "path" be defined on the assembly screen.  A short version is utilized in the "SPAW Standard" such that the "path" is set relative to all other SPAW files within a pre-programmed SPAW directory.  This is the easiest to use and recommended, however if the user has need to access files elsewhere within the disk directory, the "Full" path specification is available.

Two methods are available to select pre-defined files on a simulation screen.  A side-bar arrow on the screen entry box will provide a "Drop Down List" of all available files which pertain to the data entry box.  Selecting one of the files will enter the name and location of that file.  This is the easiest and most direct method of file selection, however if the user requires access to a file outside of the normal SPAW directory, a file selector can be chosen giving access to the full disk directory.

Two options are available to display the file directory in the screens.  The name and description are recommended for most users to utilize the full capability of file selection with best accuracy.

Manual Run 

The SPAW-Field and SPAW-pond simulations are typically initiated under the Projects main screen heading by initiating an "Open Project" screen followed by a project data screen.  However, advanced users may have reason to directly modify the "Input Data File" (xxx.spw) created by the project data screen and wish to initiate a simulation without accessing the data screen.  Thus either the field or pond model can be initiated from the "Run Directly" option.  A file selection screen allows specifying the field or pond, and the model immediately runs following selection.
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Data

Data files for field hydrology simulation are developed prior to making the SPAW-field run.  The field climate, soil, and crop data are described in separate files. The Data/Climatic Data screen is used to review, check and modify the available climatic data files which have been manually copied to the specific SPAW directory.  Soil data are obtained from local knowledge or published soil profile descriptions.  Soil water characteristics are generally estimated from the soil texture, organic matter, gravel and density.  Crop descriptors are developed from local knowledge of annual crop patterns supplemented by management options of rotations and irrigation.

Climatic Data

Minimum required climatic data are daily precipitation and monthly mean daily potential evaporation.  Daily data are most often obtained as historic files, which usually contain measured precipitation and maximum-minimum air temperature, and less often have evaporation by various methods.  Supplemental evaporation data estimates are described as "default" values for use when daily data are not available in the climatic file.  The selection of the specific climatic data file, default file and adjustments for each study site are described in the "location climate" screen.

The model accommodates many combinations of available and estimated climatic data and provides adjustments for data sources being a distance from the study field and thus somewhat different. Climatic data are available from several sources such as the NOAA National Climatic Data Center or USDA/National Water and Climate Center.   Climatic files generally include daily precipitation and max/min air temperature, but may also include evaporation, snow depth, etc.  The climate files, labeled “xxx.txt”, are manually copied into the SPAW directory at:

 “Program Files/SPAW Hydrology/SPAW/Database/Climates/Data”.  

If potential evaporation methods, such as the Penman-Monteith or Thornthwaite equations, are to be used, these calculations would be made separately before the simulation and the values placed in a climatic data file column with a corresponding heading “evap”.  The values may be entered using the CLIMATE DATA screen editor or any common spreadsheet program saved in text format with proper headings and order with tab delimiters between columns, then copied into the “Data” directory.

The "*.txt" climatic files must be in a specific format for access by the SPAW model and its CLIMATE DATA editor.  The first line must be of the exact format and wording as follows:  “XXXXXX-date  ^  tmax  ^  tmin  ^  prcp  ^  evap”, where the XX is a six digit station identification, “^” symbol denotes a single tab either side, and the designators must be spelled exactly as shown, although the order can be varied if the data are in another column arrangement.  Additional data can be included, tab delimited, and will be ignored by the read routine.  The date is in the format “mo-da-yr”, e.g. 021598 for Feb. 15, 1998.

An example first three lines of a climatic data file (xxx.txt) would be as follows:

WA6789-date
tmax
tmin
tavg
prcp
snwd
snow
stn1
stn2
stn3
stx1

100160
73.00
38.00
55.50
0.00
0.00
0.00
    
    
    
    
    

100260
78.00
39.00
58.50
0.00
0.00
0.00


The file finder of "climatic data" shows all pre-loaded climatic data files.  Opening a file initiates a climatic data editor to assist in modifying or checking the file data.  The daily data are displayed in spreadsheet form and a checking routine provides identifying missing and out-of-range values.  The data check routine generates a report file that can be saved or printed.  Any edited changes in the climate data screen will by saved into the file if the "save & exit" button is used to close the screen.

Evaporation Defaults

Daily potential evaporation is commonly not available, thus routines to estimate monthly mean daily values are often applied.  Even those climate data files with evaporation data often have missing values, particularly if pan evaporation data are recorded which are often available only during the growing season.  Since a continuous daily value is required to run the simulation, any missing values must be estimated from a default file.  Estimated values are often quite reasonable over time periods of a week of more, and values from some distance from the study site often provide reasonable values since evaporation is quite spatially conservative (not highly variable) unless there are large topographical differences.  Often a "few" (perhaps 2-4) default evaporation data sets can be used to represent regions as large as a Midwest US state.

Daily potential evapotranspiration (PET) values for the SPAW model are considered to be only the result of atmospheric variables such as radiation, wind and humidity.  All plant and soil related effects on evapotranspiration (ET) are taken into account to modify these climatically defined potential values.  Reference crop values common in irrigation scheduling would be representative only when the well-watered crop was in full growth.

The two most common potential evaporation estimates by climatic data are evaporation pan values and calculated values from climatic measurements such as the Penman method.  Pan values are an overestimate of potential PET because of their local exposure to absorb more energy and elevated water temperatures, thus reduction coefficients are required to provide a realistic estimate.  These coefficients vary over the course of the year due to energy and temperature variations.  Potential ET values estimated by Penman are usually quite close to that from an extended field of well watered, actively growing plants, thus generally no adjustments are needed.  Evaporation from a large lake, (open water evaporation), is also a close estimated to potential ET and is similar to that from Penman estimates.

Average annual potential evaporation amounts can be entered to represent either an evaporation pan or Penman (open water lake) evaporation.  These values are available from isolines on US Weather Bureau maps.  A default distribution of monthly values will distribute the annual amount, but these are changeable by entering either different monthly values or the monthly percentage.  Pan evaporation usually requires a coefficient less than 1.0 to represent potential evaporation since the pan exposure results in over estimates, whereas the Penman (Lake) approach usually is quite representative and thus has a coefficient of 1.0.  The default coefficients can be altered if local data are available.

Location Climate

The climatic data to be applied to a specific study site location is a selection of those climate data and evaporation default files previously defined.  These files are selected from the pull-down lists generated from the related file directories.  Only those files containing the selected data are shown to be available.  Note that only the files for "evaporation defaults" and precipitation are required.  Daily evaporation and air temperature are optional but useful if available.  Daily air temperatures are only used in cold weather routines for soil freezing and snow accumulation-melt, thus are essential for cold weather simulations.

Adjustment values can be applied to observed data to more correctly represent the study site if the data are known to be biased.  Precipitation and evaporation values will be prorated by the ratio of the annual Study-Site and Data-Site values.  Daily air temperatures will be biased by the entered difference.

Cold weather constants for snow melt and soil freezing simulation routines can be adjusted if necessary to more appropriately represent snow depths and soil freezing patterns.  Increasing the snow factor (0.00-5.00, default = 4.0) will increase the melt rate but does not change the accumulated depths which are estimated from air temperature and precipitation data.  Decreasing the soil freezing coefficient (0.90-1.00, default = 0.97) increases the freezing depths.  Accuracy of both snowmelt and freezing depths is limited by being only a function of air temperature as the driving variable.
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Soil

These data describe the typical soil profile to be represented by a series of layers each with its own water holding characteristics of tension and hydraulic conductivity as represented by a texture class definition.   Soil profile descriptions can be used as a guide to develop the soil layer and texture data, but modifications are generally needed to provide useful layer definitions for water movement and budgeting.
Soil Layers

The soil profile is represented by layers and entered as either  “Depth” or “Thickness”.  Each will adjust to the other as entries are made. The first layer is defaulted to be 1-inch thick to serve as an “evaporative” control layer.  The deeper layers are generally set in the range of approximately 5 to 8 inches thick to develop a complete profile to the depth of interest.  Deeper depths can readily be made up to 1-foot thick.  Bulk density default values are estimated from water saturation and mineral density of 2.65.  Sand and Clay percentages are entered as whole numbers of percent by weight.  Organic matter and gravel are entered as % by weight.  The more common metric units of g/cm^3 can be accessed with the Options/Units selection.

Selecting the symbol between sand and clay percentages initiates a texture triangle method for estimating soil water characteristics associated with soil texture.  The texture can be selected at various positions of sand-clay percentages and the estimated soil water characteristics are displayed in text and graphical form appear as the mouse is moved over the options.  Organic matter effects on the water holding characteristics are a ratio with 0.7 % average of the data used to develop the estimating equations.  The effects of salinity can be seen on the graphed tension curve as the addition of osmotic tension.  The salinity values are not shown in the soil data screen but are described in the Project/Field screen and are used in the SPAW model simulations with the same effects as shown in the texture triangle.  Bulk density is estimated in the texture triangle by assuming the estimate of saturation indicates void space and the remaining space is solid material with a density of 2.65 g/g.  Selecting “Apply” will put the set texture into the layer and use those characteristics in the simulation.  If water characteristics are known for the soil being simulated, select a texture combination which best approximates the known data.

Boundary Options

Vertical drainage is simulated by assigned characteristics of the “image” layer, which is a separate layer just below the deepest layer representing the actual soil profile.  This image layer functions as a temporary storage of percolation from the profile such that this water can either return into the profile as drying occurs or become deep drainage to groundwater when it reaches a specified moisture content.  Deep drainage out of the image layer can be set as: 1) freely draining such that water drains from the image layer when the moisture content reaches a specified percentage of the field capacity due to profile percolation, 2) restricted drainage such that water will drain from the image layer at a specified maximum flow rate (in./day) when the moisture content reaches 90% of saturation, or 3) a rising water table case in which water will flow upward at the maximum flow rate specified.  The water table case is controlled by the entered date-depth data and adjusts between dates at the deep drainage flow rate as described in the next section.

Soil water evaporation is estimated as water removed from either of the top two soil layers.  The soil profile layer one is set by default at a one-inch “evaporative” layer (EV1) in which water will freely evaporate at the potential evaporation rate minus that potential first intercepted by a plant canopy.  Water in layer one will move downward as a result of infiltration exceeding its water holding capacity and as a result of equilibrating with layer two moisture tension.  Water is not allowed to equilibrate upward from layer two because water in layer two is evaporated as next explained.

Soil water evaporation is also estimated as occurring from soil profile layer two (EV2) at a rate depending on some percentage of the unsaturated conductivity at its existing moisture content.  This represents stage-two surface drying in the traditional drying concept since layer one will have been depleted to a nearly air-dry condition at the maximum rate before the reduced rate evaporation from layer two.  The evaporation rate occurs at significantly less than the estimated unsaturated conductivity rate of layer two to account for the process of vapor transport rather than liquid transport.  The conductivity is specified as the “soil water evaporation conductivity percent” and set at a default of 5 % of the liquid conductivity.  This rate only effects layer two evaporation, thus the coefficient is only effective on a portion of the estimated soil water evaporation.  Adjusting the coefficient upward will provide additional evaporation due to effects such as tillage or cracking which would enhance the upward vapor loss from within the soil profile.

Water Table  

An option for setting a water table date-depth distribution is allowable for any depth within the soil profile.  This water table depth pattern would repeat for each year of simulation.  Water tables above the lowest soil depth will cause saturation in these layers and allow upward water movement by tension to the adjacent layers.  The rate of this water table development is controlled by the maximum image layer flow rate, in/day.
Hydrologic Group 

Runoff curve number values for the USDA/SCS method are assigned approximately according to soil texture classes.  (See User Manual, Appendix I, for associations.).  These are one of several indices combined to estimate the runoff curve numbers for the field simulation.

Ground Water Chemistry:  For those simulations involving chemistry and groundwater interaction with the soil profile, it is necessary to include estimates of ground water quality that would transport chemicals upward.  The concentration of those chemicals involved is specified as a constant value of the groundwater assuming any downward leaching would not significantly impact the groundwater quality.
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Crop

These data describe an annual distribution of a crop growth pattern and condition on a calendar year basis.  The graphs are shown for relative reference as the data points are entered in the table.  Crop development is described by three annual patterns; canopy, greenness, and rooting depth.  A fourth curve, yield susceptibility, defines the relative impact of crop water stress on grain yields over the growing season such that when accumulated for the crop year can be correlated with observed grain yields.  Example crop curves for a number of common crops are given in Appendix IIb.  For simulations involving nitrogen budgets, the nitrogen uptake annual pattern is included in the crop definitions. Crops growing over the end of the calendar year require two years of definitions.  Selecting the cropping sequence in the “management” screen develops multiple-year crop rotations.  

Canopy  

The percentage of soil surface effectively protected from solar radiation is described by date-percentage data points throughout the calendar year for linear interpolation.  The calendar year must be fully described.  Residue, green crop or some combination may all provide the canopy percentage.  The input canopy values assume plant growth with no or limited water stress.  The model adjusts the input values downward if water stress is computed.  Stress is defined as 1-AET/PET averaged for all rooted soil layers.

Greenness  

The percentage of the described canopy that is green and which can readily transpire is entered as date-percentage data points.  A newly emerging plant canopy over a bare soil would have a Greenness of 100 %.  A partial canopy of only residue would have a Greenness of 0% unless it had some green weed growth interspersed.  A maturing crop would have a declining Greenness from 100 % to near 0% as it matured and ripened to full maturity.  Greenness is an adjustment to the specified canopy percentage, not the bare soil.  As with canopy, Greenness input values are for non-stressed crops and are adjusted downward if water stress is computed.

Root Depth  

An actively transpiring canopy generally has an effective rooting system whose maximum depth moves downward at about the same pattern as the top growth (canopy) increases.  The time-depth distribution of the deepest root extension over the calendar year is described as Date-Depth data points.  The rooting density by depth is partitioned by the 40-30-20-10 rule as the maximum depths are interpolated between the input data points.  The rooting depths and seasonal patterns are quite subject to plant and soil profile characteristics and local knowledge is generally adequate for most hydrologic simulations.  Annual variations do occur due to water tables, rainfall patterns, etc. These can be represented if adequate data are available, but this information would require individual yearly simulations, thus not very applicable for long-term simulations.

Yield Susceptibility  

The susceptibility of grain production by an agricultural crop is differentially affected by water stress over the crop-growing period.  Generally, the stress effects vary from little effect at early growth and late maturity to maximum during the pollination and early grain filling periods.  This susceptibility pattern is described by a “bell shape curve” with arbitrary weighting values from 0.00 to 0.50.  These are entered as date-susceptibility data values over the calendar year.  These data are optional and have no effect on the simulated water budgets.  They are only applied when the user in interested in the impact of crop water stress on grain yields.  The accumulative yield susceptibility values over the growing season can be correlated with observed grain yields for future predictions.  

Maximum Interception  

Both plant and soil surfaces will intercept precipitation on their surfaces which then readily evaporates with little or no resistance as compared with water within the plant or soil.  The amount of maximum interception by these two surfaces, plant and soil, may be somewhat different, although defining either is difficult.  Maximum plant interception is generally about 0.10 inches and soil surfaces are usually less.  The maximum amount of interception by these two surfaces is specified separately and then combined as the canopy of a seasonal crop adds interception capability to that of bare soil surfaces.  Each day with precipitation provides water for interception up to the maximum specified minus any residual from previous days.  The intercepted water is evaporated first by the daily potential evaporation before the plant transpiration, thus the potential evapotranspiration is correspondingly reduced.  Accumulated annual intercepted water evaporation often is several inches and is a shown as the third element of actual evapotranspiration (AET) after transpiration and soil water evaporation.

Wilting Point Factor

Wilting point of most crops can generally be specified as 15 bars of soil water tension, but not all crops respond in the same manner.  Some crops will wilt at a lesser tension and those drought resistant will continue drawing water to a higher tension and thus lesser percent moisture.  A 1.0 factor would use the standard 15 bar moisture content, a value of 0.5 would decrease a soil wilting point of 8 %v to 4 %v, and a factor of 1.25 would change the 8 %v to 10 %v.

Hydrologic Curve Options  

Land Use, Treatment/Practice, and Hydrologic Condition are selected from the several standard options.  These are the cropping parameters that contribute to the estimate of the USDA/SCS curve number method shown in the Project/Field screen.  (See Users Manual, Appendix I)
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Management  

These data describe the year-to-year crop rotation to be represented by the various crops previously described, and if applicable the irrigation and nitrogen parameters for these crops in each of their respective rotation year.

Crop

For each rotation year specified, then select the appropriate crop, which must have been previously described by the “Crop” data screen.  If that crop is to be used every year for the entire simulation, then only one is required.  If a multiple year rotation is to be represented, add a second and subsequent year to the rotation years, and select the appropriate previously defined crop for that year.  This crop rotation will be repeated for the complete simulation period beginning with the first crop in the first simulation year. 

Irrigation

These data describe the type and parameters of the irrigation options.  Irrigation water is added to the precipitation to form the total water simulation budget.  

The “Irrigation Method” is used to evaluate the evaporation potential through intercepted water.  “Start” and “End” dates are for the beginning and ending dates of the irrigation season.  “Minimum Interval” defines the minimum number of days between irrigations, and “Maximum Annual Depth” is a total limit for the season.  

“Irrigation Timing” may be defined by any one of ten options.  These may be a user specified criteria or a definition to be used by the program.  Each option has unique input data entries shown when it is selected.  Essentially all options will either cause an irrigation when the date is reached, or when a wet soil has dried to the extent specified.  Many of the criteria can be changed over the course of the irrigation season by entering a date and value.  The option of “Specific Dates” requires both a calendar day and year designation and is almost always teamed with the “Specific Depth” amount option to provide an historic irrigation record.  

“Irrigation Depth” may be defined by any of six options, each with specific definition criteria to be completed as they are selected.  Several of these criteria may also be altered as the irrigation season progresses, thus entering date-value will change the criteria after the specified date.  This is often useful for defining "deficit" irrigation during selected crop growth stages.

If the irrigation water contains either salinity or nitrogen amounts sufficient to impact the chemical or water budgets, these concentrations are entered in the “Irrigation Water Chemistry” data block.  Any other chemical contained in the irrigation water can be entered as “tracer” which is assumed to not be taken up by the crop and moves with water similarly to nitrogen.

Chemical

Chemical quantities are defined for fertilizing and crop utilization.  Residue nitrogen is that in the residue at the beginning of the crop calendar year, of which 50% is assumed available to the plant over the year as it decomposes.  Annual crop nitrogen uptake is usually related to the expected crop growth and grain yield and is distributed over the year according to the curve defined in the crop screen.   Fertilizers can be specified as applied in several forms of nitrate, ammonia and urea.  These forms are released to the soil and plant in different patterns depending largely on the effects of seasonal soil temperature relationships.  A "tracer", such as Bromide or Chloride, is often useful to show only soil water interactions with chemistry since it does not interact with any of the plant growth or plant uptakes.
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Projects

The two principal hydrologic simulations, fields and ponds, are defined under the Projects menu.  Selecting either will initiate the file finder for either a previously defined simulation or a new simulation. Fields and ponds are first designated by a location, (eg. a particular farm, county or other designator meaningful to the user), and secondly as one of multiple fields or ponds at that location. (In the computer directory, location is a folder, and fields become files when viewed under SPAW/PROJECTS).  Selecting a location and field initiates the main screen for a single field hydrologic budget, and similarly for a pond.  

Field

A field is the unit of land for which a water budget simulation is made.  A "field" may be a unit of land any size which can be considered for hydrologic budgeting as uniform in climate, soil, and crops.  In many cases this can be a complete farm field, but if significant soil differences exist, it may need to be simulated in two or more partials and the results combined.  Certainly a change of crops would cause the field to be divided.  Climate may well be similar to represent a field, or even the total of a farm if precipitation or irrigation was not highly variable.

The main field screen provides for the selection of a previously defined Location Climate file (which already contains a link to precipitation, evaporation and temperature), Management file (containing crop, rotation, irrigation and chemistry information) and a soil file (previously defined).   The location climate file shows the beginning and ending dates of the data to avoid selecting simulation dates outside the range of the available data.

Observed Soil Data (moisture or chemicals) are optional and can be included if available.  These data can be used either with the option of setting the simulation to equal the observed data on the given date or just providing it for comparison with that simulated.  The Simulation Period may be all or selected portions of the period for which climatic data are available.  Runoff Curve Numbers can either be as Calculated from the soil and crop information provided, or set Manually for the fallow and cropped case if adjustments are needed to provide an improved runoff estimate (see tabled values provided later).  

Output Budgets are selectable for a variety of time periods and details.  The Detailed budgets are generally not needed unless there is interest in the computations by soil layer and individual hydrologic processes.  Select Begin Simulation and the model will assemble the various files, generate an Input Data File, and initiate the SPAW model simulation.  If all data have been properly specified, the dates of simulation will scroll on the screen as the computations are made.  The output files are then available for selection under the View menu.

Pond

Pond Depths:  All pond depths are referenced to the pond bottom.  

Infiltration:  An initial abstraction of inflow goes into the pond bottom soil before inundation begins.  In general, it would be approximately the difference between field capacity and saturation of a soil depth to that which limits seepage.  For example, 45-35% times 48 inches = 4.8 inches.

Depth Area:  The depth-area by increments from pond bottom to above spillway.

Seepage:  The expected long-term seepage below the inundated area.  This may vary with time due to freezing, etc.  Rates begin on the associated date and remain constant until the next specified date.

Water Table:  If a local regional water table exists, an annual time distribution of the levels is entered with depths in reference to pond bottom.  An example would be elevated water tables due to annual flooding of a nearby stream.  The same water table distribution is used each simulated year.  When the water table elevation exceeds the pond water elevation, seepage occurs from the water table to the pond at the specified seepage rate of the bottom soil.  Periods in which the pond water surface is higher than the water table, seepage exits the pond.  Positive seepage is an outflow from the pond, and negative seepage is water flowing into the pond.

Outlet Pipe:  The crest of the outlet pipe control is specified as depth above pond bottom.  If this outlet control is varied over the year, e.g. drop boards in an outlet, the time distribution is entered with the same time distribution each simulated year.  The stage-discharge rating of the outlet is specified as depth-discharge with depth relative to the outlet control (not the pond bottom).

Spillway:  Inflows to the pond that exceed the pond capacity (storage, seepage, evaporation, and outlet pipe capacity) are computed as spillway discharge.  The spillway elevation is specified as depth above the pond bottom, above the outlet pipe and less than the uppermost depth-area value.  Spillway outflow is computed daily and is assumed uncontrolled by a stage-discharge curve.  

Watershed Fields:  One or more fields must have been simulated with the field model prior to running the pond simulation.  All previously run fields will appear with the pull-down menu.  The watershed can be comprised of one or multiple fields as specified.  The dates of the field simulations are given for reference such that the pond simulation will not be outside of these dates for any specified watershed field.  The area of each field in acres and the estimated percent of deep drainage from that field that enters the pond (interflow) are entered.

Irrigated Field:  If one or more fields are to be irrigated with the pond water, these must have been previously simulated with a field run, then selected and size specified.  The efficiency of irrigation entered as the percent of water required for the irrigation divided by the amount of water needing to be drawn from the pond, e.g. 80 % efficiency for an irrigation of 1 ac-ft would require 1.25 ac-ft withdrawal.

External Input:  If there is an external source of pond water, for example an offsite pump or wash water from an animal housing facility, enter the start date, ending date and flow rate.   Use multiple dates and rates if appropriate.  If the external source is to be controlled by the stage within the impoundment, enter the upper and lower limits.  The pump will start at the lowest limit and stop at the upper limit.

Supply Pump:  If there is a pump to remove pond water for a water supply, such as stock water, specify start date, end date and rate.  Multiple dates and rates can be entered as appropriate or if more than one pump is involved.  The pump will turn off when a lower limit is reached, but begin pumping again if the depth returns above the lower limit and the date is within the specified pumping period.  A supply deficiency is recorded for all days during which the supply was specified but the pond was too dry to provide the water.

Drawdown Pump:  If a drawdown pump is in place such as that used to remove water from a lagoon, specify the start date, ending date and flow rate.  If the pump is to be controlled by the pond stage, it will start when the upper limit is reached and stop at the lower limit if within the dates specified.

Wetland Growing Season: If a wetland is being analyzed, set the Start and End dates of the “wetland growing season” and the minimum days of inundation during the growing season that would qualify as a wetland period.  (Criteria for setting the beginning and end of the growing season were established by the National Food Security Act, 3rd Edition, 1994).

Simulation dates:  Set to be equal or within the dates used for any of the previously run field simulations for the watershed representation or irrigated fields as shown on the field designations.  

Output Budgets are designated by time period and degree of information.  Detailed budgets are generally not needed.  

Begin Simulation to generate an input file and execute the POND simulation.  A scroll bar indicates the simulation progress and completion.  Resulting files are available under the View menu.
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View

Files generated by either a Field or Pond simulation can be selected under the View menu.  All output files are stored on the computer disk under the directory SPAW Hydrology/Spaw/Projects.  An open Field or Pond project file determines the files available for viewing.  Multiple fields or ponds can be opened and viewed if desired.  The files are available directly after the simulation, or can be re-opened at any later time by again selecting the Project Field or Pond.  Each file can be printed or saved to the same project directory under a new name.  This routine is especially useful for multiple runs of a field or pond since each identical named simulation generates the identical file names based on the field or pond name and thus will write over any existing files of the same designator.  All files are labeled with user and applied file descriptions, followed by labeled variables.  Most standard word processing or spreadsheet programs can also view the output files files.

Annual, Monthly, Daily Budgets

Hydrologic budgets for various time periods are provided for a variety of applications.  Each has full heading information followed by the unique data.  Columns and units designate the data.  Average data for the appropriate time simulated are shown at the end of each summary table.  A simulation period average of the variables is included as the final lines of each budget.

Irrigation Summary

A summary of the field irrigations by date and amount.

Depth Duration

Pond output tables provide the details of simulation user and files plus the descriptive data of the simulated impoundment.  The output is an annual summary of days and depths of the simulated inundated pond.

Inundation

The inundation file provides the details of simulation user and files plus the descriptive data of the simulated impoundment.  The output is a summary of inundation periods defined as individual periods when broken by one or more days of dry pond.  This is most useful for the hydrology of wetland hydrology.

A statistical summary of all inundation periods for the entire simulated period is provided at the end of the report.  The percentage of years that the inundation periods met the criteria of wetland hydrology (inundated for more than "X" days within a specified "Wetland Growing Season") shown by each 10% of the pond depth defines the depth at which various percentages of the years would have met the wetland definition.

Detailed Budget

A detailed hydrology report of the field simulation and contains more information than the other budget files.  It is used principally for simulation accuracy assurance or more detailed information than otherwise provided.  Three levels of output can be selected.  Minimum shows only daily totals, Medium provides budgets for each soil layer, and Maximum provides soil water movement each delta time increment within the daily soil water redistribution for each soil layer.

Input Data File

Each field and pond simulation is an assimilation of various input data from the screens and files.  The input data file is written as the first step in the simulation and is used as the principle input data for each simulation.  It is primarily useful for error checking and simulation quality assurance.  Advanced users may exercise the option of directly altering this file and using the manual run under Options.

Graph

A separate graph routine is used to visually view nearly all daily hydrologic values within the budgets.  A separate graph file is written during the simulation data for this routine.  Upon selection, the program reads the entire graph file, processes variable ranges and prepares for the user selection of variables.  Most variables are available as either daily values or accumulative values over the calendar year.  Soil water values by total profile or each soil layer are selectable.  A particularly useful combined graph of water in all layers is shown under the label "Stack" which relates well to the various variables that determine daily soil water.  Chemical values are available under a separate tab.  The pond graph is similar to that of the field with both daily and accumulative variable values over each calendar year.
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Window

The arrangement of open windows is selectable as in most "WINDOW" programs.  Multiple windows can be open within the memory capability of the computer and are listed and selectable under the window menu.  Multiple windows are useful for sequential simulations or combined simulation outputs.
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Help

Three documents are provided for user information and help.  The first is a summarized "SPAW Operational Manual" fully indexed and available within the program using F1 keys or the Help Menu Index.  Two other documents are accessible within the HELP files, or can also be found in the file directory labeled "SPAW Hydrology/SPAW/Help" within the main disk directory.  A full "Users Manual" provides a printable document useful for ready reference to the operations of the SPAW/POND model and the data input screens under the file name "SPAW Users Manual.doc”.  A more extensive document about the model development, internal routines and programming details is provided under the file name "SPAW Reference Manual.doc".  Separate images of the Field and Pond system and process schematics are also provided within the Help directory.

Content, Index and Search

These tabs under the Help menu provide access and search capability to the users Screen Help.

About SPAW

This screen displays the model version number.  As with most programming, this model has had extensive development steps that likely will continue.  It is important when requesting help or comparing results to note the version number of the program.  This number is also included in all output tables.  
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